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Software requirements

For this tutorial you will need the following software installed:

 Meshroom [Windows / Linux]

 (https://alicevision.org/#meshroom)

e Blender 2.8 or above [Windows / Mac / Linux]
e (https://www.blender.org/download/releases/2-80/)

e Unity Hub [Windows / Mac / Linux]
* (https://unity3d.com/get-unity/download)

e Unity (version 2019.2.12f1) & Unity account [Windows / Mac / Linux]
 (https://unity3d.com/get-unity/download/archive)

 AltspaceVR (via Windows Store or Steam) and an AltspaceVR account
 (https://altvr.com/)



https://alicevision.org/
https://www.blender.org/download/releases/2-80/
https://unity3d.com/get-unity/download
https://unity3d.com/get-unity/download/archive
https://altvr.com/

Download Unit

1. Navigateto the
Unity Website
and find the
“individual”
license versions

@ unity Store

Plans and pricing

We offer a range of plans for all levels of expertise and industries.
All plans are royalty-free.

Individual Business

During the COVID-19 situation, we're offering three

Student Personal

Learn the tools and workflows professionals use Start creating with the free version of Unity

on the job Learn Premium

Master Unity with expert-led live sessions

Free Free and on-demand learning
Gatmnw I -
Eligibility: Eligibility: Included with Plus, Pro and Enterprise plans

Students enrolled in an accredited educational institution of Revenue or funding less than $100K in the last 12 months
legal age to consent to the collection and processing of their
personal information, e.g., age 13 in the US, 16 in the EU. Must

jointhe GitHub Student Developer Pack to be verified.

7 Latest version of the care Unity development platform +/ Latest version of the care Unity development platform
+/ Unlimited access to Learn Premium +/ Resources for getting started and learning Unity

+ Five seats of Unity Teams Advanced C‘ ~ompare plans

" Dark theme Ul -

+/ Realtime cloud diagnostics

months of complimentary access to Learn Premium.

2. Choose
Individual and click
“Get Started” to
download the free
Personal license
version.

Download Unity: hitps://store.unity.comy#plans-individual


https://store.unity.com/

Download Unity Hub

@ unity Products  Solutions Made with Unity  Learning Support & Services

1. Navigateto the
“Download

Unity” page DOWM|Oad Uﬂﬁy
Welcome! You're here because you wantto d world's most popular development platfarm for creating 2D
D multiplatform games and interactive e es. 2 Clle ”Download Unlty
Before g ad choose the version of Unity that's right for you

Hub” and follow the
installationinstructions for
“UnityHubSetup.exe”

Learn more about the new Unity Hub here.

Download Unity: hitps://unity3d.comy/get-unity/download


https://unity3d.com/get-unity/download

Adding Unity 2019.2.12f1 to Unity Hub

Q unity  Products  Solutions  Made with Unity  Le

g  Support & Services

* Open Unity Hub on your desktop

4 Unity Hub 2.3.0 - O .

@ unity e e

Unity download archive

. . Long Term Support releases Patch Releases
j PrGJeCt:’ PrOJects ADD The LTS ish to continue to Ne
develop ntent and stay on a fix
stable v ed perio rele:
- Learn - S
Project Name Unity Version Target Platform Last Modified -] Q Download patch releases

&% Community
BCD_Planning_Tool_Desktop_v2

= Installs 2019.2.3f1 Current platform 3 menths ago unity 2019% - Unity 2018 Unity 2017 Unity Sx Unity 4x - Unity 3.
BCD_Space_And_Place Unjtmﬁm%o N [
C:\Users\olive\Documents . 2019.1.0f2 Current platform 4 months ago :'":
R Unily 201315 I [
. . . 28 ""l;"‘ "'I
* Later we will be using the AltspaceVR Uploader which P
requires Unity version 2019.2.12f1 e
* Navigate to the Unity download archive in your web P
browser ot T

* Scroll down the page until you find Unity 2019.2.12
* Click the green ‘Unity Hub’ button next to it

§
i

* It should start downloading in Unity Hub

Unity downloadarchive:



https://unity3d.com/get-unity/download/archive

Adding Unity 2019.2.12f

€ Unity Hub 2.3.0 - O X

* Check “Android Build
Support” to allow you to

build AltspaceVR apps for
Mobile VR

[] ios Build Support B86.1 MB 3.6 GB ® Cl ic k ”I n Sta I |”

[] tvos Build support 326.7 MB 1.4GB

Add Unity Version

Add modules to Unity 2019.2.12f1 : total space available 633.8 GB - total space required 6.6 GB

[J vinux Build Support 90.6 MB 469.0 MB

D Mac Build Support (Mono) 82.7 MB 463.1 MB d U n ity 2 O 1 9 . 2 . 1 2f1 Wi I I be
) vt st added to your list of Unity
[] windows Build Support (IL2CPP) f:f::?n j:iiz :z I N Sta I IS an d Sta rt

[ Earshnnk camearanm Build Sonnart

o 4 downloading -

[] universal windows Platform Build Support 269.7 MB 2.06GB




Using Unity — Starting a new project from Unity Hub

* In Unity Hub select Projects and click the button next to “New”

* Select Unity version 2019.2.12f1

* Select “3D” and provide a name for the project
* Use the “Unity” folder in the “3D Project” folder as the save location

e Click “Create”

& unity 2 O

3 Projects Projects Aop m -
arn
et hia nity Versio gel i odifi

BCD_Planning_Tool_Desktop_v2 2019.3.3f1

2019.2.15f1
,,,,,,,,,,,,,,,,,,,
: : ! Al 2019.2.12R1
360 Video 2019.2.311
C:\Users\olive\D ents\Unity Proje 2019.2.15f1 current platform 5 months ag o

2019.1.0f2

2018.3.411

Probuilder

New AltspaceVR Project

C:

\Users\garet\OneDrive\Desktop\3D Proje.. ...

|
Click “CREATE”



Using Unity— The basics (User Interface)

Hierarchy
Panel lists
the contents
of the
current
scene

The Project
Tab is used
to manage
your project
and provides
a view of
your Assets
folder where
3D models,
textures and
other game
content are
stored

Standalone - Unity 2019.2.12f1 Personal <DX11> — X

File Edit Assetz GameObject Component Window Help

[ + BFEAEIGER

= Hierarchy
| create -| Gral

# Scene ® Inspector
| shaded

v €{ sampleScene

| /Main Camera
|| Directional Light

=

B3 Project =]
| creare -

v 7 Favorites
(©1All Materials
(©LAll Models
(©L Al Prefabs

{55 Scenes
» G5 Packages

Assets

Scenes

Inspector
Tab displays
the
properties of
selected
game objects

Scene View
is the
window
whereyou
arrange and
view game
objects in
your scene



Using Unity — Importing the edited model

1. Right-clickin
the “Assets”
window of the
“Project” and
then go to
“Create” and
“Folder”

@ New AltspaceVR Project - SampleScene - PC, Mac & Linux Standalone - Unity 2019.2.12f1 Personal <DX11> - X
File Edit Assets GameObject Component Window Help

= Hierarchy H Scene
| Ereate -| (ErANl | shaded | % | m - Gizmos - | (GrAT )

- Assets
YQSampleS(ene = -
L 'Main Camera

@ Inspector

|/ Directional Light

Folder

C# Script
Shader »
Create > Testing >

Show in Explorer Playables »

Open Assembly Definition
Delete Assembly Definition Reference
Rename TextMeshPro 4
Copy Path Alt+Crl+C
Scene
Open Scene Additive Prefab Variant
Import New Asset... Audio Mixer
Import Package >
P 5 Material
Export Package...
Lens Flare
Find References In Scene
Render Texture
Select Dependencies :
Lightmap Parameters
Refresh Ctrl+R Custom Render Texture
Reimport
Sprite Atlas
Reimport All Sprites 2
Extract From Prefab Animator Controller
| Create - Run API Updater... Animation
v | Favorites Assets Animator Override Controller
1 All Materials | Update UIElernents Schema
Avatar Mask

©LAll Models

@AII Prefabs - s B g Timeline
Signal

Physic Material

Physics Material 2D

GUI Skin

Custom Fent Asset Labels

Legacy >

- st

2. Callthe new folder “Model” and doubleclick to open it



Using Unity — Import the edited model Blender model

X

]

q Mew AltspaceVR Project - SampleScene - PC, Mac & Linux Standalone - Unity 2019.2.12f1 Personal <DX11=
File Edit Assets GameQObject Component Window Help

S | b | o | & | # ] [ >ecenter | @Local | m | @collab - | [ & | [Account - | [Layers - | [Layout - |

“Z Hierarchy W= Scene € Game £ Asset Store == @ Inspector o=

Create 7| (Grall Shaded WIEENE R E IR ETY | ¥ | W 7| Gizmos - | (Erall Modsl %
v €} SampleScene = i ' CE,, “

. Main Camera \l
.. Directional Light o

2. Navigateto the

.0bjthe you’ve just

exported from

: ' ' - Blender and select

Show in Explorer

~ both the “Model”
R : .0bj

Open Scene Additive

Import New Asset..,

Import Package >
Export Pac

Find Referel n Scene

Select Dep ies

1. Right-click in the

Reimport ™

“Assets/Model”

Extract Froi ab

fOIder WindOW and T El Console E"";ip‘:E - | Import ‘
then select AN
“Import New | - > .

Asset” e

Asset Labels

5 Assets/Model [—pe— /ssctBundle  [Hane

3. Click “Import”

Aute Generate Lighting On



Using Unity — Importing the Meshroom model texture

) New AltspaceVR Project - SampleScenc - PC, Mac & Linux Stendalone - Unity 2019.2.12f1 Personal <DX11> - X
File Edit Assets GameObject Component Window Help

C[F BB %] [center [ Siocl | > 11 M [ Coltab - L & N ecourt < I cavers < N tevout <]

= Hierarchy 8 -= #sScens € Game (5 Asset Store = © Inspector a-=

| Create - | (Br Al Shaded SIENEAEINED | % | W -] Gizmos -] (Brall %,
v & samplescens = o e ; En ]

Main Camera \f —

2. Navigate to the Meshroom

folder containingthe initial

textured mesh you imported

S ’ [ e oo e into Blender

Open
Delete

Rename
Copy Path e

3. Select the .png

B

colle <]

Open Scene Additive {

P \

Import New Asset... texture 1001.pnc
imecr Pactase : texture

Export Package...

Find Reference: s In Scene

Select Dependencies

Refresh Ctri+R
1. Right-clicki :
. Right-click in
h Extract From Prefab
t e Run AP| Updater...
rea Update UlElements Schema -

“Assets/Model”
folder and select ...

ﬂ!—
“Import New | >
Asset” as before

Open C# Project
i

e ] | 4. Click “Import”

NOTE: You'll find the Meshroom model by navigating to the “3D Project folder”: 3D Project\Model\MeshroomCache\Texturing\
The folder is named with a long sting of alphanumeric characters. Inside you’ll find the .png file you are looking for.



Using Unity — Create a material and apply the texture

Q) New AltspaceVR Project - SampleScene

File Edit Assets GameObject Compo

e —

1. Right-click \@j
in the

“Assets/Mode
|” folder but
this time
select Create
> Material

2. The
material
v{};hvuntes

82

4. Drag and

Shader | Standard

Rendering Mode | Opagque

drop the

1 “Texture” file

(olle

Enable GPU Instancing | |
Double Sided Global III/_|

should now
©1 All Materials

appearin the ﬁm"‘“—>

“Model”
folder.

3. Left-click on the materialand look over to the
“Inspector window” on the right for more information

0
Metallic Alpha + Ove r to t h e
o" V24
Albedo” map
a
G on the
~ oDetail Albedo x2 mate rla I
~ oNormal Map 1
Tiling X1 Y[z ]
offset X0 Yo |
UV Set [uvo 4]
Forward Rendering Options
Specular Highlights ¥4
Reflections 4




Using Unity — Working with the model in your scene

1. Drag and
drop the
“Model” file
into the
“Hierarchy”
window

€& New AltspaceVR Project - Sar

File Edit Assets GameObject Con

@ Project | ] Console.

cene € Game £ Asset Store
ade zll2o]| @ [ ]2z 7o
i

The model should now appearin the
“Scene” window

148 % #s]]

¥ Model

Tag | Untagged

| Create ~ |
¥ |/ Favorites
©1 Al Materials
©1 All Models
(©1 All Prefabs

v (i Assets

& Scenes
» G Packages

Hold down the right mouse buttonand move the

mouse to look about the scene and use the W, A, S

and D keys to move around

+| Layer [Default
Model | Open I Sel. || overrid,
¥ .~ Transform
Position X 0 Yo
Rotation X0 Yo
Scale X1 Y[1

Add Component

Scale the
model to
make it

<:| bigger or

smaller on
the X, Y,and Z
scale. You can
also change
its position
and rotation

Alternatively
use the move
scale and
rotate
functions
appearing
above the
“Hierarchy”



Using UnityeMaking the model solid

€ New Altsp Project - Sam e - PC, Mac & Linux 2 2 D - g

File Edit Assets GameObject ltspaceVR W 2 In the

N . ‘. T - . -  a= " ”

e » T — s Inspector

v €} sampleScene* . | Open |
¥ | Environment e i
window, select
'nvod:fault -E : | !

| Directional Light Scene o 9
| Plane Scale Factor {1 M O d e I

' Audio Sour
|/ Audio Source Convert Units

Import BlendShapes
Import Visibility
Import Cameras
Import Lights
Preserve Hierarchy
Sort Hierarchy By Namév/

1| 3. tick “Generate

Mesh Compression | off s

I e FK . | Colliders”

1cm (File) to 1m (Unity)

(Y

Generate Colliders "4

Geometry

Keep Quads J

Weld Vertices ¥4

Index Format | Auto 3.1

Legacy Blend Shape Nol_|

Normals | Import n

Blend Shape Normals | Calculate +

Normals Mode Area And Angle Weighted 4

Smoothness Source Prefer Smoothing Groups 4 . “ ”
S - 4. Click “Apply

Tangents | Calculate Mikktspace al .

Swap UVs J

Generate Lightmap UVs[_|

Revert IAppIy |

Imported Object

=

@1 Project | 2

| Create ~| q [EYEYERE= R ) « Model Static ¥
v | /Favorites Assets > Model Tag [ Untagged i | Layer | Default i |
(©) Al Materials ¥ . Transform [BE:3

©) All Models Position Yo 'zlo
(©. All Prefabs

Model =

v i Assets
» G Altspace defaultMat Model

& Plugins
» (G Prefabs
& Resources
& Scenes
» G Packages

1. Select the “Model” in the “Project” Window



Using Unity — Delete the camera

< New AltspaceVR Project - SampleScene - PC, Mac & Linux Standalone - Unity 2019.2.12f1 Personal* <DX11> = X
File Edit Assets GameObject Component Window Help

S [ [[5][&5] % | [tcenter [ @Local |

§| #HiScene

| % | W Gizmos -| @Al [

) ¥ 'Main Camera | [ static =

\7 & Tag | MainCamera 4| Layer | Default 4]

Delete the
“Main Camera”
by right-clicking
and selecting
delete - the
camerais not
needed
because
AltspaceVR will
provide its own
when you
uploadyour
scene

. ol ¥ .~ Transform ﬁ o
o' s

Paste Position X0 Y 0.31 Z|0.85

L/ default Rotation X Y |177.803 |Z |0
i Scale X1 Y |1 Z[1
Duplicate
pl v& ¥ camera b
5 Clear Flags [ Skybox 4
Select Children Baﬁkgmndk h_f
Culling M E; i 4
Select Prefab Root L Inginas verithing
Projection | Perspective 1)
Creat=tmpty FOV Axis Vertical |
3D Object Field of View 160
2D Object Physical Camera L
Effects Clipping Planes Near 0.3 |
Light Far 1000 |
Audi Viewport Rect X0 Y 0
i w H
Video
Depth -1 |
i Rendering Path Use Graphics Settings 0
Camera Target Texture ‘None (Render Texture) e
Occlusion Culling ¥4
HDR Use Graphics Settings +
MSAA _mm os 3]
Allow Dynamic Resoluti{_|
Target Display | Display 1 &
(@) ¥ Audio Listener e
[ Add Component ]

@ Project
| Create 'I
v | Favorites Assets > Model
QAII Materials
©1 All Models
@AII Prefabs

v (il Assets

defaultMat
& Scenes
» & Packages




Using Unity — Inserting a plane

< New AltspaceVR Project - SampleScene - PC, Mac & Linux Standalone - Unity 2019.2.12f1 Personal* <DX11>
File Edit Assets GameObject Component AltspaceVR Window Help

Right-click in the S EEEX]

# Scene
| Shaded

«
il

“Hierarchy” T geamplescens:
. > NiModel
window and

select “3D

Duplicate

O bj eCt” => ::II::Children
“Plane”

Select Prefab Root

Create Empty
3D Object > Cube
2D Object > Sphere
Effects > Capsule
Light > Cylinder
Plane
Video Quad
ul > Text - TextMeshPro
Camera Ragdoll...
] Terrain
Tree
Wind Zone

3D Text

Proj [El Console
| Clear || Collapse | Clear on Play | Clear on Build | Error Pause | Editor *|

(] [Plane 7 [ static ~
Tag | Untagged 4| Layer [Nav Mesh 3]
¥ .~ Transform Ead
Position X0 Y |-1.02 74 [1]
Rotation X0 Y0 Z 0
Scale X1 Y1 Z[1
¥/ Plane (Mesh Filter) Q@ = %
Mesh WPlane [}
v .\ ¥ Mesh Renderer @ = =
¥ Materials
Size L |
Element 0 [ Transparent ‘e
¥ Lighting
Cast Shad [ on 4]

Receive Shadows [V

Contribute Global Illu_|

Receive Global Illum( Light Probes 1
¥ Probes

Light Probes Blend Probes

Refecton probes

Anchor Override None (Transform) [0}
¥ Additional Settings
Motion Vectors | Per Object Motion 4.
Dynamic Occlusion v
¥ ;i) ¥ Mesh Collider o
Convex
Is Trigger J
Cooking Options | Mixed.., 4.
Material [None (Physic Material) :)
Mesh W Plane o)
Transparent @ = %=
> Shader | Standard -]
[ Add Component ]




Using Unity — Positioning the plane

© Inspector e

= Hierarchy

Jem ) ¥ | @ = = =
l c:z SL;PAI:Scene* =L J & [Plane | L static >
¥ Environment Tag | Untagged ¢] Layer [MNavMesh B
» hiModel v .~ Transform =
| Directional Light Position X0 Y [-1.02 {
Rotation X0 Y 0 NET0 T
Scale X1 ¥ [1 1z[1 1
52 il ot
Y et ——_@ss  Position the new
¥ .. ¥Mesh Renderer @ = .
plane just under
Size 1z |
I 0 @ Transparent J:]
the model
Cast Shadows [on N
Receive Shadows
Contribute Global Illu_|
Receive Global Illumi Light Probes 4]
¥ Probes . .
Light Probes | Blend Probes i) Th I S Ste p WI I |
Reflection Probes | Blend Probes ™

Anchor Override ‘None (Transform) [l
prevent you from
Motion Vectors  [PerObjectMotion ¢

Dynamic Occlusion =5 i m m ed i a te I y

v E:n?eh:esh Collider . 3
:o?k;%g(g};iom [E;J‘l_ixed.(“h i - ;] fa I | i n g Off th e
i L m— edge of the
» Shader | Standard - m O d e | i n
[ Add Component ]
R AltspaceVR.
v{}éa;r;l::sﬁm Assets > Model
Qo
pes i ! You can scale the
- MOd efaultMat Model texture_10.. Transparent .
S, plane to suit your
bﬁ?ni‘l::‘;:s Sce n e *




Using Unity — Customizing the plane

L= Mew AltspaceVR Project - SampleScene - PC, Mac & Linux Standalene - Unity 2019.2,12f1 Personal* <DX11> - s
File Edit Assets GameObject Component AltspaceVR Window Help

¥ + Elaniol

ierarchy # Scene

| Create -| (@Al Shaded = e =
v €} SampleScene* -
¥ |/ Environment Cpen
> iy Model
|/ Directional Light
L,/ Plane

User Preferences
Folder

C# Script
Shader

1. Right-clickin
the “Assets” =>
“Model” folder —

Show in Explorer

and select

Delete Prefab Variant

IICreate” a nd Rename Audio Mixer

Testing

Playables >
Assembly Definition

Assemnbly Definition Reference
TextMeshPro >

Copy Path
“ . ” » Material
IVI ate rl a I Open Scene Additive [T -y
Import Mew Asset., Render Texture
Import Package > Lightmap Parameters
Export Package... Custom Render Texture
Find References In Scene Sprite Atlas
Select Dependencies Sprites s
2 L f I . k Refresh Ctrl+R Animator Controller
. Left-clickon s mamenn
reate ~
¥ 1 Favarites Assets > Mo« Reimport All Animator Override Controller
t h e n eW (©LAll Materials [ Avatar Mask
(L All Models Extract From Prefab
@AH Prefabs Timeline
|,1,1 H ’ ITT Run AP| Updater...
aterl a S n a e v & Assets Update UlElements Sch el
b G5 Altspace At ——— Physic Material
rrl Open C# Project 3 .
a n d re n a e th e (&4 Plugins P ) Physics Material 2D
» G Prefabs Ul Skin
.
| I late rl a I | et (Fant: Asset Labels
» Gl Packages
Legacy >
Bundle None Mone

“Transparent” s — oo



Using Unity — Customizing the plane 2. With the

o
Transparent
File Edit Assets GameObject Component AltspaceVR Window Help .
‘ G ‘ :ﬂ: j m I ;*\‘ ' % ] [ =i Center | GL?caI I ‘ [_QCoIlab v‘l @ lAccount - ][Lavels v][ Layout ,v l m a te rl a I Sel ected ,

“= Hierarchy | AltspaceVR Build Settings d-= #Scene | €Game {3 Asset Store = © Inspector | &=

| create -| @Al z|[20 ] @ [ |2t -] %o % | Mt - Gizmos -~
‘ Wt set the render

v € sampleScene*

¥ . Environment Shader | Standard J
» &y Model Rendering Mode | Transparent <
| Directional Light B d t
¥ Main Maps
S p mode to

70Albedo |
a— ‘ “Transparent”

h O [1
Source Z/\\{i: Alpha 2

— —~

©Normal Map
= ©Height Map

©Occlusion H

3. Click on the
Emission

o Ve - “Albedo” color box

©Detail Albedo x2 | a n d Set IIA” to Ze ro

i M ] in the pop-up

Forward Rendering C ns Color n Wi n d OW

Specular Highlights
Reflections

Advanced Options

Enable GPU Instancing
Double Sided Global IIl

@ Project | [l Gonsole. &=
Create 7| /[ / @ [ [* [#s]
V{}favorites Assets > Model / /

©) All Materials
©) All Models
(©) All Prefabs

ETR

Transparent—— —————
v Gl Assets Al
» G Altspace defaultMat Model SO L Transparent : = :
T |z
& Plugins :
» (G Prefabs . =
&l Resources A
(& Scenes
e Hexadecimal | FFFFFF

AssetBundle one v ¥ Swatches =
4 @ Click to add new preset

1. Drag and drop the “Transparent” material onto the plane 4. Set “Smoothness” to “1”



Using Unity — Setting up for audio

Right-click in the
“Hierarchy”
window and select
“Audio” => “Audio
Source”

& New AltspaceVR Project - SampleScene - PC, Mac & Linux Standalone - Unity 2019.2.12f1 Personal* <DX11> = X
File Edit Assets GameObject Component AltspaceVR Window Help

© + BEAEIGIER

= Hierarchy # Scene

|c;.a5~| q"f" < Ehadad texture_1001 Import Settings 3%
¥ Environment Open
g S:T'dzlh | Light Texture Type | Default 2.
irectional Lig
2D s
Carlane Texture Shape [ )|
SRGB (Color Texture) o
Alpha Source Input Texture Alpha e
Alpha Is Transparency [_|
» Advanced
C Wrap Mode | Repeat 4]
opy 5 T
Filter Mode | Bilinear ™
Paste Aniso Level —
RenaAme Default BT
Duplicate ¥ Override for PC, Mac & Linux Standalone
Delete Max Size | 2048 3
Select Children Resize Algorithm | Mitchell |
Format RGB Compressed DXT1 4

Select Prefab Root

Create Empty

3D Object >
2D Object >
Effects >

Light >
Audio >
Video >
ul > |

Camera

@1 Project
| create 7|
¥ | /Favorites

©) All Materials
© All Models
(©. Al Prefabs

Assets > Model

texture_1001

7 G Assets
» (i Altspace
(& Plugins
» (i Prefabs
& Resources
Scenes
» & Packages

defaultMat

Transparent

tBundle MNone

Assets/Model/texture_1001.png



Using Unity — Setting up the audio object

- - . 2.Position the
QCoIIabv E Account ~ Layers = Layout v audio Object to

€ New AltspaceVR Project - Sampl PC, Mac & Linux Standalone - Unity 2019.2.12f1 Personal* <DX11>

File Edit

Assets GameObjec Alts| ndow Help

= Hierarchy AltspaceVR Build Settings - Gan - © Inspector 3

}c;ué ;Lm(q ::zs“ne‘ ‘E\‘I z[20|[ @ || 2 ix] o | | % | W -] Gizmos - | GrAT ) @ [udo Soures” [Cistatic > t h e Cente r Of
¥ Environment . Tag | Untagged + Layer [Default %)

1. Select the SRt e - E— the model

“ . ’ane : Rotation X Y0 U
Au d I 0 Audio Source Zboren Scale X Y0 z[o ]
v =] ¥ Audio Source =
- AudioClip None (Audio Clip) [} .
Source” in the o T 3. Tick Both
Mute m]

Bypass Effects (]} “ P I a y O n

Bypass Listener Effects |

“Hierarchy” e
Play On Awake ¥4 < | Awa ke” and

.
window “
Priority —— e [126 | "« ”
Volume u LO O p
pitch —e e [T |
Stereo Pan — 0
Left Ri

Spatial Blend m—:QE 4_ Set ”Spatial

Reverb Zone Mix —— 1

¥ 3D Sound Settings | d ”n Haqn”n
Doppler Level —— 1| B e n to 1
Spread Or— [0_
Volume Rolloff Logarithmic Rolloff s
Min Distance 18
Max Distance 500
o
" 5. Set the “Max
1.4
L H ”
Distance™ to
0.8
@ Project | ] Gonsolt == =
L C— O reach the edge
¥ | [Favorites Assets > Model L
%An Materials 05 f t h d |
All Models 0.4
©lan Proefalu i (0] e mode
v Gl Assets S 0.2
» i Altspace defaultMat Model texture_10.. Transparent 0.1
Plugml ) vsn 100 150 200 250 300 350 400 450 500
’ ;:f:::m. W Volume  ® Spatial  ® Spread [ Reverb
& Scenes
» (& Packages Add Component ]




sing Unity — Importing audio

< New AltspaceVR Project - SampleScene - PC, Mac & Linux Standalone - Unity 2019.2.12f1 Personal* <DX11>
File Edit Assets GameObject Component AltspaceVR Window Help

S | X \:(*&):\ ‘f«] | *tCenter | @Local

J

® = #HScene

€ Game

= X

| & collab ~ | @ | Account ~ | |Layers ~||Layout - | 2. In the pop_

| | shaded

= Hierarchy | AltspaceVR Build Settings
| Create ~| @Al
v & sampleScene* e
~ ¥ Environment
» &iModel

|/ Directional Light
|_/Plane
| Audio Source

1. Right click in
the Project

@ Project | [E]Cansole

| Create |
v | /Favorites

window, and
select“Assets”

Assets > Model

=> " M O d e | n => '?és:;::ace defaultMat  Model
“Import New © L >
» G Packages

Asset”

& Assets/Model

-;~‘B.

texture_10.. Transparent

,ﬁ’»

Show in Explorer
Open

Delete

Rename

Copy Path Alt+Ctrl+C

Open Scene Additive
Import New Asset...
Import Package

Export Package...

Find References In Scene
Select Dependencies

Refresh Ctrl+R

Reimport

Reimport All

Extract From Prefab

Run AP| Updater..

Update UlElements Schema

Open C# Project

&=

Q EIIEAED

e O o up window,
navigateto

— PG Detaog » 0Pt » i “Audio”

' folderin “3D

Project” and

select your
audio
recording
from earlier
e
3. Click

“Import”

Asset Labels

AssetBundle None

Auto Generate Lighting On
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Using Unity — Importing aud

& New Alt  Project - Sample G Unity 2 D - a
File Edit Assets GameObject Component AltspaceVR Window Help
(ORI S (=B E @ coliab - | [ & | [Account - ] [Layers - |
Hierarchy X B S 5= 3 Scene © Inspector i =
1, SEleCt the | Create ~| (@Al ) || | Shaded | % | Bt - Gizmos I-| @Al - .
v Q T Ly ¥ 'Audio Source | [[] static ¥
(lA u d i O So u rce’, i n ¥ Environment Tag | Untagged 4| Layer | Default gl
» hiModel ¥ A Transform Ead
|/ Directional Light Position X|2.78 Y |-9.16 Z1.16
“ap: ’ Rotation x[0 ¥ /o zlo
t e Iera rC y Scale X0 Y 0 zo
. v =] ¥ Audio Source - 4
WI n d OW AudioClip “Head )
Output 'None (Audio Mixer Group) (]
M m
a
sypass Listener Effects |
Bypass Reverb Zones [ |
Play On Awake ¥4
Loop ¥4
Priority 128
High Low
Volume —) |1
Pitch 1
Stel 0
feoihan Lefe Right o |
patial Blen, s =S

Reverb Zone Mix ——— 1
¥ 3D Sound Settings

Doppler Level —— |
Spread (Or—
Volume Rolloff | Logarithmic Rolloff 4
Min Distance 18
Max Distance 1500
1.1
1.8 o
4
0.9
0.8
&3 Project 0.7
| Create ‘| 0.6
¥ | Favorites Assets > Model L
O All Materials i
© All Models 0.4
(© Al Prefabs 0.3
v G Assets a2
» G Altspace defaultMat Model texture_10.. Transparent 0.1
0.g
*
D S50 100 150 200 250 300 350 400 450 500
W Volume B Spatial W Spread [ Reverb
Scenes
» Gl Packages Add Component ]

2. Drag and drop the new audiofile to the “AudioClip” boxin the
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